Modelica is a modern, strongly typed, declarative, equation-based, and object-oriented language for modeling and simulation of complex systems. Major features are: ease of use, visual design of models with combination of lego-like predefined model building blocks, ability to define model libraries with reusable components, support for modeling and simulation of complex applications involving parts from several application domains, and many more useful facilities. This paper gives an overview of some aspects of the Modelica language and the OpenModelica environment – an open-source environment for modeling, simulation, and development of Modelica applications.

Keywords: Modelica, OpenModelica, Modeling, Equation-Based, Open Source

Main Author's biography:
Peter Fritzson is a Professor and Director of the Programming Environment Laboratory (PELAB), at the Department of Computer and Information Science, Linköping University, Sweden. Peter Fritzson is chairman of the Scandinavian Simulation Society, secretary of the European simulation organization, EuroSim; and vice chairman of the Modelica Association. His main area of interest is software engineering, esp. design, programming languages and environments, including modeling and simulation.

Presenting Authors' biographies:
Håkan Lundvall, MSc, is a PhD student at PELAB, Linköping University, Sweden. He is involved in the OpenModelica efforts since several years, and has among other things designed and implemented the hybrid and discrete event support. His main area of interest is generation of parallel code from Modelica, targeting clusters and multi-core architectures.

Jan Brugård, MSc, is the CEO of MathCore Engineering AB, Linköping, Sweden. He is an experienced modeler with several years of experience of modeling complex engineering applications, primarily mechanical and electrical applications, and is a driving force behind the development of the MathModelica System Designer product.
1 Introduction

A large number of modeling and simulation tools are available on the market. Most tools are very specialized and only address a specific application domain. These tools usually have incompatible model formats.

However, certain tools are of a more general nature. For modeling and simulation of dynamic systems, we have e.g. the following de-facto standards:

- **Continuous**: Matlab/Simulink,... [15], MatrixX/SystemBuild, Scilab/Scicos, ACSL,... for general systems, SPICE and its derivates for electrical circuits, ADAMS, DADS/Motion, SimPack, SimMechanics,... for multi-body mechanical systems, ANSYS, FEMLAB, etc. for finite-element analysis, ...

- **Discrete**: general-purpose simulators based on the discrete-event GPSS line, VHDL- and Verilog simulators in digital electronics, etc.

- **Hybrid** (discrete + continuous): Modelica, gPROMS [2], AnyLogic, VHDL-AMS and Verilog-AMS simulators (not only for electronics but also for multi-physics problems), etc.

The insufficient power and generality of the former modeling languages has stimulated the development of Modelica (as a true object-oriented, multi-physics language) and VHDL-AMS/Verilog-AMS (multi-physics but primarily for electronics, and therefore often not general enough).

1.1 Modelica Background

In 1996 several first generation object-oriented mathematical modeling languages and simulation systems (ObjectMath [9], Dymola [6] [7], Omola [16], NMF [22], gPROMS [2], Allan, Smile, etc.) had been developed.

However, the situation with a number of different incompatible object-oriented modeling and simulation languages was not satisfactory. Therefore, in the fall of 1996, a group of researchers from universities and industry started work towards standardization and making this object-oriented modeling technology widely available. This language is called Modelica [10][17][23] and designed primarily for modeling dynamic behavior of engineering systems; moreover, meta-modeling extensions have recently been developed [11]. The language is intended to become a de facto standard.

The language allows defining models in a declarative manner, modularly and hierarchically and combining various formalisms expressible in the more general Modelica formalism. The multidomain capability of Modelica allows combining electrical, mechanical, hydraulic, thermodynamic, etc., model components within the same application model.

Compared to most widespread simulation languages available today this language offers several important advantages:

- **Object-oriented mathematical modeling**. This technique makes it possible to create model components, which are employed to support hierarchical structuring, reuse, and evolution of large and complex models covering multiple technology domains.

- **Acausal modeling**. Modeling is based on equations instead of assignment statements as in traditional input/output block abstractions. Direct use of equations significantly increases re-usability of model components, since components adapt to the data flow context in which they are used. Interfacing with traditional software is also available in Modelica.

- **Physical modeling of multiple application domains**. Model components can correspond to physical objects in the real world, in contrast to established techniques that require conversion to “signal” blocks with fixed input/output causality. In Modelica the structure of the model naturally correspond to the structure of the physical system in contrast to block-oriented modeling tools such as Simulink. For application engineers, such “physical” components are particularly easy to combine into simulation models using a graphical editor.

- **A general type system** that unifies object-orientation, multiple inheritance, components/connectors, and templates/generics within a single class construct.

Hierarchical system architectures can easily be described with Modelica thanks to its powerful component model. Components are connected via the connection mechanism realized by the Modelica system, which can be visualized in connection diagrams. The component framework realizes components and connections, and ensures that communication works over the connections.

For systems composed of acausal components with behavior specified by equations, the direction of data flow, i.e., the causality is initially unspecified for connections between those components. Instead the causality is automatically deduced by the compiler when needed. Components have well-defined interfaces consisting of ports, also known as connectors, to the external world. A component may internally consist of other connected components, i.e., hierarchical modeling. Fig. 1 shows hierarchical component-based modeling of an industry robot.
The OpenModelica environment described in this paper primarily focuses on the open-source tool effort. OpenModelica, which currently is the major Modelica implementation, was started in Linköping, Sweden year 2000, and a conference series was started the same year, with the 5th conference in Vienna Sept. 2006. Several commercial implementations of Modelica (i.e., subsets thereof) are available, including Dymola [5], MathModelica [14], and IDA [3]. This paper primarily focuses on the OpenModelica, which currently is the major Modelica open-source tool effort.

2 The OpenModelica Environment

The OpenModelica environment described in this paper has several goals, including, but not limited to the following:

- Providing an efficient interactive computational environment for the Modelica language.
- Development of a complete reference implementation of Modelica in an extended version of Modelica itself.
- Providing an environment for teaching modeling and simulation. It turns out that with support of appropriate tools and libraries, Modelica is very well suited as a computational language for development and execution of both low level and high level numerical algorithms, e.g. for control system design, solving nonlinear equation systems, or to develop optimization algorithms for complex applications.
- Language design, e.g. to further extend the scope of the language, e.g. for use in diagnosis, structural analysis, system identification, etc., as well as modeling problems that require extensions such as partial differential equations, enlarged scope for discrete modeling and simulation, etc.
- Language design to improve abstract properties such as expressiveness, orthogonality, declarativity, reuse, configurability, architectural properties, etc.
- Improved implementation techniques, e.g. to enhance the performance of compiled Modelica code by generating code for parallel hardware.

- Improved debugging support for equation based languages such as Modelica, for improved ease of use.
- Easy-to-use specialized high-level (graphical) user interfaces for certain application domains.
- Visualization and animation techniques for interpretation and presentation of results.
- Application usage and model library development by researchers in various application areas.

In this paper we briefly present a few of the subsystems, as well as some architectural aspects of the environment. Further, we will give examples of the usage of the interactive session handler, the DrModelica notebook, and the debugging support.

2.1 Environment Overview

The OpenModelica environment consists of several interconnected subsystems, as depicted in Fig. 2.

Arrows denote data and control flow. Several subsystems provide different forms of browsing and textual editing of Modelica code. The debugger currently provides debugging of an extended algorithmic subset of Modelica. The graphical model editor is not really part of OpenModelica but integrated into the system and available from MathCore [14] without cost for academic usage. The following subsystems are currently integrated in the OpenModelica environment:

- An interactive session handler, that parses and interprets commands and Modelica expressions for evaluation, simulation, plotting, etc. The session handler also contains simple history facilities, and completion of file names and certain identifiers in commands.
- A Modelica compiler subsystem, translating Modelica to C code, with a symbol table containing definitions of classes, functions, and variables. Such definitions can be predefined, user-defined, or obtained from libraries. The compiler also includes a Modelica interpreter for interactive usage and constant expression evaluation. The subsystem also includes facilities for building simulation executables.
linked with selected numerical ODE or DAE solvers.

- **An execution and run-time module.** This module currently executes compiled binary code from translated expressions and functions, as well as simulation code from equation based models, linked with numerical solvers. Limited event handling facilities are included for the discrete and hybrid parts of the Modelica language.

- **Emacs textual model editor/browser.** In principle any text editor could be used. We have so far primarily employed Gnu Emacs, which has the advantage of being programmable for future extensions. A Gnu Emacs mode for Modelica has previously been developed. The Emacs mode hides Modelica graphical annotations during editing, which otherwise clutters the code and makes it hard to read. The Emacs mode has been largely superceded by the Eclipse plugin described below.

- **Eclipse plugin editor/browser/compilation manager.** The Eclipse plugin [21] provides file and class hierarchy browsing and text editing capabilities. Some syntax highlighting facilities are also included. The Eclipse framework has the advantage of making it easier to add future extensions such as refactoring and cross referencing support. A compilation manager is also included. Automatic indentation and debugging facilities are recently being added [20].

- **DrModelica notebook textual model editor.** This subsystem provides a lightweight notebook editor, compared to the more advanced Mathematica notebooks available in MathModelica. This basic functionality still allows essentially the whole DrModelica tutorial to be handled. Hierarchical text documents with chapters and sections can be represented and edited, including basic formatting. Cells can contain ordinary text, graphics, or Modelica classes, and expressions, which can be evaluated and simulated. However, no mathematical typesetting facilities are yet available in the cells of this notebook editor.

- **Graphical model editor/browser.** This is a graphical connection editor, for component based model design by connecting instances of Modelica classes, and browsing Modelica model libraries for reading and picking component models. The graphic model editor is not really part of OpenModelica but a MathModelica Lite version of the editor, see Section 9, is integrated with the system and provided by MathCore AB [14] without cost for academic usage. The graphic model editor also includes a textual editor for editing model class definitions, and a window for interactive Modelica command evaluation.

- **Modelica debugger.** The current implementation of the debugger [18] provides debugging for an extended algorithmic subset of Modelica, excluding equation-based models and some other features, but including some meta-programming and model transformation extensions [11] to Modelica. This is conventional full-feature debugger, using Emacs for displaying the source code during stepping, setting breakpoints, etc. Various back-trace and inspection commands are available. The debugger also includes a data-view browser for browsing hierarchical data such as tree- or list structures in extended Modelica. As just mentioned, this debugger has been integrated in the OpenModelica Eclipse plugin.

### 2.2 Implementation Status

The current version of the OpenModelica environment (June 2007) allows most of the expression, equation, algorithm, and function parts of Modelica to be executed interactively, as well as to being compiled into efficient C code. The generated C code is combined with a library of utility functions, a run-time library, and a numerical DAE solver. An external function numeric library interfacing a LAPACK subset and other basic algorithms has also recently been developed.

Not all subsystems are yet integrated as well as is indicated in Fig. 3. Currently there are two versions of the Modelica compiler, one which supports most of standard Modelica including simulation, and is connected to the interactive session handler, the notebook editor, and the graphic model editor, and another meta-programming Modelica compiler version which is integrated with the debugger and Emacs, supports meta-programming Modelica extensions [11], but does not allow equation-based modeling and simulation. Those two versions are currently being merged into a single OpenModelica compiler version.

### 3 The OpenModelica Client-Server Architecture

The OpenModelica client-server architecture is schematically depicted in Fig. 3, showing three typical clients.

![Client-Server interconnection structure of the compiler/interpreter main program and interactive tool interfaces.](image-url)

**Fig. 3.** Client-Server interconnection structure of the compiler/interpreter main program and interactive tool interfaces.
The three clients are: a graphic model editor, an interactive session handler for command interpretation, and the MDT Eclipse plugin.

Commands or Modelica expressions are sent as text from the clients via the CORBA interface, parsed, and divided into two groups by the main program:

- All kinds of declarations of classes, types, functions, constants, etc., as well as equations and assignment statements. Moreover, function calls to the untyped API also belong to this group – a function name is checked if it belongs to the API names. The Interactive module handles this group of declarations and untyped API commands.
- Expressions and type checked API commands, which are handled by the Ceval module.

The reason the untyped API calls are not passed via SCode (a module generating an intermediate form of the abstract syntax tree) and Inst (which performs symbolic instantiation of components) to Ceval is that Ceval can only handle typed calls – the type is always computed and checked, whereas the untyped API prioritizes performance and typing flexibility. The Main module checks the name of a called function name to determine if it belongs to the untyped API, and should be routed to Interactive.

Moreover, the Interactive module maintains an environment of all interactively given declarations and assignments at the top-level, which is the reason such items need to be handled by the Interactive module.

4 Simplified Overall Structure of the Compiler

The OpenModelica compiler is divided into a number of modules, to separate different stages of the translation, and to make it more manageable. The top level function is called main, and appears as follows in simplified form that emits flat Modelica (leaving out the code generation and symbolic equation manipulation):

```modelica
function main
  input String f "file name";
protected
  Absyn ast;
  SCode scode1;
  SCode scode2;
algorithm
  ast := Parser.parse(f);
  scode1 := SCode.elaborate(ast);
  scode2 := Inst.elaborate(scode1);
  DAE.dump(scode2);
end main;
```

The simplified overall structure of the OpenModelica compiler is depicted in Fig. 4, showing the most important modules, some of which can be recognized from the above main function. The total system contains approximately 40 modules.

Fig. 4. The OpenModelica compiler (omc) decomposed into modules and data flow connections.

The parser generates abstract syntax (Absyn) which is converted to the simplified (SCode) intermediate form. The code instantiation module (Inst) calls Lookup to find a name in an environment. It also generates the DAE equation representation which is simplified by DAELow. The Ceval module performs compile-time or interactive expression evaluation and returns values. The Static module performs static semantics and type checking. The DAELow module performs BLT sorting and index reduction (see Chapter 18 in [10]). The DAE module internally uses Exp.Exp, Types.Type and Algorithm.Algorithm; the SCode module internally uses Absyn.

5 Interactive Session with Examples

The following is an interactive session using the interactive session handler in the OpenModelica environment. (Called OMSH – the OpenModelica Shell).

The Windows version which at installation is made available in the start menu as OpenModelica->OpenModelica Shell responds with an interaction window shown in Fig. 5.

We enter an assignment of a vector expression, created by the range construction expression \(1:12\), to be stored in the variable \(x\). The value of the expression is returned.

Fig. 5. Initial screen of the interactive session handler.

5. Interactive Session with Examples

The following is an interactive session using the interactive session handler in the OpenModelica environment. (Called OMSH – the OpenModelica Shell).

The Windows version which at installation is made available in the start menu as OpenModelica->OpenModelica Shell responds with an interaction window shown in Fig. 5.

We enter an assignment of a vector expression, created by the range construction expression \(1:12\), to be stored in the variable \(x\). The value of the expression is returned.
Look at the type of \( x \):

\[
\texttt{typeOf}(x) \quad \text{"Integer[12]"} \\
\]

The function \texttt{bubblesort} is called to sort this vector in descending order. The sorted result is returned together with its type. Note that the result vector is of type \texttt{Real[],} instantiated as \texttt{Real[12]}, since this is the declared type of the function result. The input \texttt{Integer} vector was automatically converted to a \texttt{Real} vector according to the Modelica type coercion rules. The function is automatically compiled when called if this has not been done before.

\[
\texttt{bubblesort}(x) \\
\{12, 11, 10, 9, 8, 7, 6, 5, 4, 3, 2, 1\} \\
\]

It is also possible to give operating system commands via the \texttt{system} utility function. A command is provided as a string argument. The example below shows the \texttt{system} utility applied to the UNIX command \texttt{cat}, which here outputs the contents of the file \texttt{bubblesort.mo} to the output stream. However, the cat command does not boldface Modelica keywords – this improvement has been done by hand for readability.

\[
\texttt{cd("C:/OpenModelica1.4.0/testmodels")} \\
\texttt{system("cat bubblesort.mo")} \\
\]

\[
\texttt{function bubblesort} \\
\texttt{input} \texttt{Real[]} \texttt{x; } \texttt{output} \texttt{Real[\text{size}(x,1)]} \texttt{y; } \texttt{protected} \\
\texttt{Real} \texttt{t; } \texttt{algorithm} \\
\texttt{y := x; } \texttt{for} \texttt{i} \texttt{in 1:size(x,1)} \texttt{loop} \\
\texttt{for} \texttt{j} \texttt{in 1:size(x,1)} \texttt{loop} \\
\texttt{if} \texttt{y[i] > y[j]} \texttt{then} \\
\texttt{t := y[i]; } \texttt{y[i] := y[j]; } \texttt{y[j] := t; } \\
\texttt{end if; } \texttt{end for; } \texttt{end for; } \texttt{end bubblesort;} \\
\]

We also load a file containing the \texttt{dcmotor} model:

\[
\texttt{loadFile("C:/OpenModelica1.4.0/testmodels/dcmotor.mo")} \\
\]

It is simulated:

\[
\texttt{simulate(dcmotor,\text{startTime}=0.0,} \\
\texttt{\text{stopTime}=10.0)} \\
\text{resultFile = "dcmotor_res.plt"} \\
\]

We list the source code of the model:

\[
\texttt{list(dcmotor)} \\
\texttt{*model dcmotor} \\
\texttt{Modelica.Electrical.Analog.Basic.Resistor} \\
\texttt{r1(R=10);} \\
\texttt{Modelica.Electrical.Analog.Basic.Inductor} \\
\texttt{i1;} \\
\texttt{Modelica.Electrical.Analog.Basic.EMF emf1;} \\
\texttt{Modelica.Mechanics.Rotational.Inertia load;} \\
\texttt{Modelica.Electrical.Analog.Basic.Ground g;} \\
\texttt{Modelica.Electrical.Analog.Sources.ConstantVoltage v;} \\
\texttt{equation} \\
\texttt{connect(v.p,r1.p);} \\
\texttt{connect(v.n,g.p);} \\
\texttt{connect(r1.n,i1.p);} \\
\texttt{connect(i1.n,emf1.p);} \\
\texttt{connect(emf1.n,g.p);} \\
\texttt{connect(emf1.flange_b,load.flange_a);} \\
\texttt{end dcmotor;} \\
\]

We plot part of the simulated result:

\[
\texttt{plot\{load.w,load.phi\}} \\
\]

We load a model, here the whole Modelica standard library:

\[
\texttt{loadModel(Modelica)} \\
\]

And then call the function:

\[
\texttt{MySqr(input Real x; output Real y; algorithm y:=x*x; end MySqr;}} \\
\]

Another built-in command is \texttt{cd}, the \texttt{change current directory} command. The resulting current directory is returned as a string.

\[
\texttt{cd(".\")} \\
\texttt{*/home/petfr/modelica*"} \\
\]

We load a model, here the whole Modelica standard library:

\[
\texttt{loadModel(Modelica)} \\
\]

We also load a file containing the \texttt{dcmotor} model:

\[
\texttt{loadFile("C:/OpenModelica1.4.0/testmodels/dcmotor.mo")} \\
\]

It is simulated:

\[
\texttt{simulate(dcmotor,\text{startTime}=0.0,} \\
\texttt{\text{stopTime}=10.0)} \\
\text{resultFile = "dcmotor_res.plt"} \\
\]

We list the source code of the model:

\[
\texttt{list(dcmotor)} \\
\texttt{*model dcmotor} \\
\texttt{Modelica.Electrical.Analog.Basic.Resistor} \\
\texttt{r1(R=10);} \\
\texttt{Modelica.Electrical.Analog.Basic.Inductor} \\
\texttt{i1;} \\
\texttt{Modelica.Electrical.Analog.Basic.EMF emf1;} \\
\texttt{Modelica.Mechanics.Rotational.Inertia load;} \\
\texttt{Modelica.Electrical.Analog.Basic.Ground g;} \\
\texttt{Modelica.Electrical.Analog.Sources.ConstantVoltage v;} \\
\texttt{equation} \\
\texttt{connect(v.p,r1.p);} \\
\texttt{connect(v.n,g.p);} \\
\texttt{connect(r1.n,i1.p);} \\
\texttt{connect(i1.n,emf1.p);} \\
\texttt{connect(emf1.n,g.p);} \\
\texttt{connect(emf1.flange_b,load.flange_a);} \\
\texttt{end dcmotor;} \\
\]

We plot part of the simulated result:

\[
\texttt{plot\{load.w,load.phi\}} \\
\]

The output is shown in Fig. 6.

![Fig. 6. Plot of the simulated dcmotor model.](image)
We load another model, the Influenza model:

```plaintext
>> loadFile("M:/modeq/VC7/Setup/testmodels/Influenza.mo")
true
```

It is simulated:

```plaintext
>> simulate(Influenza,startTime=0.0, stopTime=3.0)
record
resultFile = "Influenza_res.plt"
end record
```

The simulated population is plotted, which is shown in Fig. 7.

```plaintext
>> plot({Infected_Popul.p})
true
```

Fig. 7. Plot of the Influenza model.

For a complete list of the available commands, see [13].

6 DrModelica Notebook and Textual Model Editor

The OpenModelica electronic notebook (OMNotebook) and model editor subsystem [1] [8] can be used as a textual modeling interface for Modelica, or as a Modelica tutoring system, i.e., a simplified version of the earlier Mathematica-based DrModelica tutoring system for teaching Modelica.

The simplified OpenModelica electronic notebooks are however able to handle the full DrModelica tutorial material, containing most of the Modelica examples in [10]. It is advanced enough to represent hierarchical documents, simple type setting, text editing, graphic cells, etc.

Fig. 8. The start page (main page) of DrModelica in the OpenModelica notebook system.

This is exemplified by Fig. 8, showing the DrModelica main page (start page) in the teaching material.

6.1 Some OpenModelica Notebook Commands

The current prototype of OpenModelica notebooks includes, but is not limited, to the following operations:

- Opening and closing groups of cells by double clicking the hierarchical tree view (to the right).
- Evaluation of Modelica code, commands, and expressions in input cells by typing SHIFT+RETURN. The evaluation results are shown in a created output cell.
- Opening loading, and saving notebook files in XML (.onb) format.
- Terminating the notebook subsystem (ALT+Q or ALT+F4).
- Select a cell, by a single click on the cell in the tree view to the right.
- Possibility to edit the style template to change the appearance of different cell types.
- Move cursor, by CTRL + UP ARROW or CTRL + DOWN ARROW.
- Close current document (CTRL+W).
- Select and copy text inside a cell.

7 Modelica Algorithmic Subset Debugger

This section presents a comprehensive Modelica debugger [18] for an extended algorithmic subset of the Modelica language. The debugger replaces debugging
of algorithmic code using primitive means such as print statements or asserts which is complex, time-consuming and error-prone.

Two versions of the debugger has been developed. The first version, [18], is based on Emacs as user interface. The second more recent and substantially improved version is integrated in Eclipse as part of the OpenModelica MDT Eclipse plugin, and is being released at the time of this writing. Some aspects of this new debugger are described in [19].

The debugger is portable since it is based on transparent source code instrumentation techniques that are independent of the implementation platform.

The usual debugging functionality found in debuggers for procedural or traditional object-oriented languages is supported, such as setting and removing breakpoints, single-stepping, inspecting variables, backtrace of stack contents, tracing, etc.

In this section we present parts of the Emacs version of the debugger functionality. Some of the functionality of the Emacs version of the debugger is shown Fig. 9.

### 7.1 Debugger Commands

The Emacs Modelica debug mode is implemented as a specialization of the Grand Unified Debugger (GUD) interface (gud-mode) from Emacs. Because the Modelica debug mode is based on the GUD interface, some of the commands have the same familiar key bindings.

The actual commands sent to the debugger are also presented together with GUD commands preceded by the Modelica debugger prompt: mdb@>

If the debugger commands have several alternatives these are presented using the notation:

```
alternative1|alternative2|...
```

The optional command components are presented using notation: `[optional]`.

In the Emacs interface: `M-x` stands for holding down the Meta key (mapped to Alt in general) and pressing the key after the dash, here `x`, `C-x` stands for holding down the Control (Ctrl) key and pressing `x`, `<RET>` is equivalent to pressing the Enter key, and `<SPC>` to pressing the Space key.

### 7.2 Starting the Modelica Debugging Subprocess

The command for starting the Modelica debugger under Emacs is the following:

```
M-X modelicadebug <RET> executable <RET>
```

### 7.3 Setting/Deleting Breakpoints

A part of a session using this type of commands is shown in Fig. 9 below.

![Fig. 9. Using breakpoints.](image)

This is only a brief presentation of a subset of the debugger functionality. See the OpenModelica Users Guide [13] for a more complete description.

### 8 Modelica Development Tooling (MDT) Eclipse Plug-In

The Modelica Development Tooling (MDT) Eclipse Plugin [21] integrates the OpenModelica compiler with Eclipse. MDT, together with the OpenModelica compiler, provides an environment for working with Modelica development projects.

The following features are available:

- Browsing support for Modelica projects, packages, and classes
- Wizards for creating Modelica projects, packages, and classes
- Syntax color highlighting
- Syntax checking
- Code completion
- Automatic indentation
- Automatic display of information about declared items
- Browsing of Modelica modules and libraries

### 8.1 Using the Modelica Perspective

The most convenient way to work with Modelica projects is to use to the Modelica perspective. To switch to the Modelica perspective, choose the Window menu item, pick Open Perspective followed by...
Other... Select the Modelica option from the dialog presented and click OK.

8.2 Creating a Project

To start a new project, use the New Modelica Project Wizard. It is accessible through File->New->Modelica Project or by right-clicking in the Modelica Projects view and selecting New->Modelica Project.

8.3 Creating a Package

To create a new package inside a Modelica project, select File->New->Modelica Package. Enter the desired name of the package and a description of what it contains.

8.4 Creating a Class

To create a new Modelica class, select where in the hierarchy that you want to add your new class and select File->New->Modelica Class. When creating a Modelica class you can add different restrictions on what the class can contain. These can for example be model, connector, block, record, or function.

When you have selected your desired class type, you can select modifiers that add code blocks to the generated code. ‘Include initial code block’ will for example add the line ‘initial equation’ to the class.

8.5 Syntax Checking

Whenever a Modelica (.mo) file is saved by the Modelica Editor, it is checked for syntactical errors. Any errors that are found are added to the Problems view and also marked in the source code editor. Errors are marked in the editor as a red circle with a white cross, a squiggly red line under the problematic construct, and as a red marker in the right-hand side of the editor. If you want to reach the problem, you can either click the item in the Problems view or select the red box in the right-hand side of the editor.

9 Graphic Editing with MathModelica Lite

A model can be built using the graphical model editor by using drag-and-drop of already developed and freely available model components from the Modelica Standard Library.

The Modelica Standard Library can be loaded into the OpenModelica environment when the MathModelica Lite model editor is started and can be browsed using the class browser visible at the left of Fig. 13 below.

This section just gives a short sample of using the graphical model editor. See www.mathcore.com for the complete MathModelica System Designer User’s Guide, which includes additional capabilities in modeling, simulation, plotting, and Modelica library support.

As mentioned previously, there is no graphical model editor in OpenModelica, but the Lite edition of the MathModelica model editor from MathCore that works together with OpenModelica can be downloaded from the OpenModelica web site or di-
Fig. 13. The model editor of MathModelica Lite with the class browser to the left, the graphic editing area in the middle, and the instance component browser to the right.

10 Conclusion

We have presented some aspects of the OpenModelica environment, including facilities for modeling, simulation, and debugging Modelica code. A number of objectives of the OpenModelica environment have been presented and some examples illustrated. It has been demonstrated that the OpenModelica environment includes many valuable features for engineers and researchers, and it is the only Modelica environment so far with good support for debugging Modelica algorithmic code as well as support for meta-programming integrated in the language. We believe that this open source platform can be part of forming the foundation of the next generation of the Modelica language and environment development efforts, both from a research perspective and a system engineering usage point of view.

11 Acknowledgments

This work was supported by SSF in the VISIMOD project, by Vinnova in SafeModSim project, by Vetenskapsrådet, by Linköping University, and by MathCore Engineering AB. Thanks to Ingemar Axelson and Anders Fernström for design and implementation regarding the OMNotebook, and to Andreas Remar and Elmir Jagudin for design and implementation regarding the MDT Eclipse plugin.

Note: Most of the material presented in this paper has been previously published, especially as part of [12] and [10].

12 References


